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EPSON Stylus CX5400 User’s Guide
This User’s Guide contains instructions on copying, printing, scanning, maintenance,
troubleshooting, network printing, and specifications. The Quick Reference Guide
contains instructions for using your EPSON Stylus® CX5400 without a computer.
To set up your EPSON Stylus CX5400 and install its software, see the Start Here
sheet.
Please follow these guidelines throughout:
Warnings must be followed carefully to avoid bodily injury.
Cautions must be observed to avoid damage to your equipment.
Notes contain important information about your EPSON Stylus CX5400.
Tips contain hints for better copying, scanning, and printing.
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EPSON Stylus CX5400 Parts
Transportation lock

Paper support
Feeder guard

Scanner lid

LCD screen

Document table

Output tray

Paper thickness
lever

Scanner

Ink cartridges
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Loading Paper
■

Single Sheets

■

Envelopes

■

Special Papers

Single Sheets
1. Open the output tray and its extension.
2. Flip the feeder guard forward.
3. Insert your paper against the right edge of the sheet feeder.
4. Slide the left edge guide against the paper (but not too tightly).
5. Flip the feeder guard back over the paper.
Note: Make sure you didn’t insert the paper in front of the feeder guard.

Insert paper against
the right edge

Flip the feeder
guard back onto
the paper

Slide the left edge
guide against the
paper, but not too
tightly

Open the output tray
and extension

Also be sure to:
■

Load the printable side face-up. It’s often whiter or brighter than the other side.

■

Load letterhead or preprinted paper top edge first.
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■

Load paper short-edge first, even for landscape-oriented documents and photos.

■

Don’t load paper above the arrow on the left edge guide.

■

Load up to approximately 100 sheets of plain paper at a time.

If you’re loading envelopes or special paper, see the next sections.

Envelopes
1. Load up to 10 envelopes at a time, flap edge left, and printable side up, against the
right edge of the sheet feeder.
2. Slide the left edge guide against the envelopes (but not too tightly).

Load envelopes
printable side up,
and flap edge left
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3. Lift up the scanner and set the paper thickness lever to the
to set it back to the position when you’re done).

position (remember

Set the thickness
lever to the
position

Note: For best results, press each envelope flat before loading, or load one
envelope at a time.

4. Lower the scanner until it clicks into place.
Select the following settings when printing on envelopes:
■

Plain paper as the Type or Media Type setting

■

The correct envelope size as the Size (Windows®) or Paper Size (Macintosh®)
setting

■

Landscape as the Orientation setting

For instructions on selecting these settings, see:
■

Printing From an Application (Windows)

■

Printing With Macintosh OS 8.6 to 9.x

■

Printing With Macintosh OS X
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Special Papers
EPSON® offers the following special ink jet papers for the EPSON Stylus CX5400:
Paper name*

Size

Part number

EPSON Premium Bright White Paper

Letter (8.5 x 11 inches)

S041586

EPSON Photo Quality Ink Jet Paper

Letter (8.5 x 11 inches)

S041062

A4 (8.3 x 11.7 inches)

S041061

Legal (8.5 x 14 inches)

S041067

EPSON Photo Quality Ink Jet Cards

A6 (4.1 x 5.8 inches)

S041054

EPSON Photo Paper or EPSON
Glossy Photo Paper

4 x 6 inches

S041134/S041671

Letter (8.5 x 11 inches)

S041141/S041649
S041271/S041272

A4 (8.3 x 11.7 inches)

S041140

Letter (8.5 x 11 inches)

S041257

8 x 10 inches

S041467

EPSON Double-Sided Matte Paper

Letter (8.5 x 11 inches)

S041568

EPSON Premium Semigloss Photo
Paper

Letter (8.5 x 11 inches)

S041331

EPSON Ink Jet Transparencies

Letter (8.5 x 11 inches)

S041064

EPSON DURABrite® Ink Glossy
Photo Paper

Letter (8.5 x 11 inches)

S041731

4 x 6 inches

S041734

EPSON Matte Paper Heavyweight

* The availability of paper types varies by location.

To get the best prints and copies, use genuine EPSON ink and paper. You can
purchase ink cartridges, paper and accessories from your local retailer. Please call
(800) 463-7766 to locate a retailer near you.
To load EPSON special ink jet papers, follow these guidelines:
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Paper type

Loading capacity

Premium Bright White Paper

125 Sheets

Photo Quality Ink Jet Paper

100 sheets, or up to 50 sheets of legal-size paper

Photo Quality Ink Jet Cards

30 cards

Glossy Photo Paper or Photo Paper

20 sheets

Matte Paper Heavyweight

20 sheets with a support sheet beneath the stack

Double-Sided Matte Paper

1 sheet

Premium Semigloss Photo Paper

20 sheets

Ink Jet Transparencies

30 sheets with a sheet of plain paper beneath the
stack

DURABrite Ink Glossy Photo Paper

20 sheets

■

Load all paper with the printable side up. It’s usually whiter or brighter than the
other side.

■

Always load the short edge first, even for landscape-oriented photos or
documents.

■

If the paper has a cut corner, position it in the upper right corner as you load it in
the sheet feeder.

■

Check the paper package for additional instructions on using special papers.
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Copying
■

Copying Without the Computer

■

Changing Copy Settings

■

Copying With the Computer

Copying Without the Computer
1. Open the scanner lid.
2. Place your document face-down on the glass, in the upper left corner. Move your
document about 0.1 inch from the top and side edge so your entire document is
scanned.

Move the document
in about 0.1 inch from
the edges

Note: If you place your document against the guides, the edges next to the
guides won’t be copied.
If you need to copy a thick document, such as a book, you can remove the
scanner lid to scan. Gently press down the original to keep it flat on the document
table. Be sure to replace the scanner lid when you’re finished.

3. Close the scanner lid.
4. The default copy settings are displayed on the control panel. Change any
necessary copy settings, as described in Changing Copy Settings.
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5. Press the Color Copy button (for color copies) or B&W Copy button (for black
and white copies). Your document is scanned and then printed. If you’re using the
2-up or 4-up Copy Mode setting (see Type of Copies), repeat these steps for your
second page.
Note: Depending on the copy settings chosen, your copied image size may not
be the exact same size as your original.

Changing Copy Settings
The current copy settings are shown on the LCD screen. You can change copy
settings using the buttons, as described below.
LCD screen

Reset
button

Menu
buttons

Copies/Value buttons
(+ and –)

Stop
button

Note: To clear a setting, press the Reset button. To clear all the setting changes
you’ve made, press and hold the Reset button for at least 3 seconds.
Make sure you select your Copy mode before selecting any other copy settings.

Number of Copies
Press the + Copies button. If you’re using the 2-up or 4-up Copy mode setting (see
Type of Copies), you can’t select more than one copy.
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Type of Copies
Press the right Menu button to display Copy mode on the LCD screen. Then press
the + or – Value buttons to select one of these copy modes:
Copy mode

Results

Standard Margins
Copies your original with a normal
margin (0.12-inch or 3 mm)

Border Free
Sizes your original as necessary to
fit to the edges of 4 x 6 or 5 x 7
paper*
Small Margins
Copies your original onto 4 x 6 or
5 x 7-inch paper with a 0.06-inch
(1.5 mm) border around the edges*
Repeat
Copies an image multiple times on
one sheet
(Works best with originals that are
business-card-size or smaller)
2-up
Copies two originals onto one
sheet

4-up
Copies four originals onto one
sheet

* If you notice reduced print quality at the bottom of your copy, try using the Standard Margins
setting.
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Note: The Copy mode settings determine the options available with other
settings. Not all of the other options described here are available with every Copy
mode setting.

Paper Size
Press the right Menu button until you see Paper size on the LCD screen. Then press
the + or – Value buttons to select the size of the paper you loaded, either Letter,
4 × 6, 5 × 7, or A4 (8.3 × 11.7 inches).
Note: The 4 × 6 Paper size option is not compatible with Glossy Photo Paper,
4" x 6", with micro perforated edges (S041134 and S041671).

Lighten or Darken
Press the right Menu button until you see Lighter/Darker on the LCD screen. Then
press the + or – Value buttons to lighten or darken your copies.

Copy Quality
Press the right Menu button until you see Quality&Paper on the LCD screen. Then
press the + or – Value buttons to select a print quality appropriate for your document
and the paper you loaded:
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Quality&Paper setting

Use when you’ve loaded

Plain Paper–Econ

Plain paper or Premium Bright White Paper for quick
copying with draft print quality

Plain Paper–Norm

Plain paper or Premium Bright White Paper for text copying
with normal print quality

Plain Paper–Fine

Plain paper or Premium Bright White Paper for text and
graphics copying with high print quality

Plain Paper–Best

Plain paper or Premium Bright White Paper for improved
image quality

Matte Paper HW

Matte Paper Heavyweight or Double-Sided Matte Paper

Photo Paper

Photo Paper, Glossy Photo Paper, or Premium Semigloss
Paper

DB Photo Paper

DURABrite Ink Glossy Photo Paper

Note: Not all of these settings may be available, depending on the current Copy
mode setting.

Reduce or Enlarge
Press the right Menu button until you see Reduce/Enlarge on the LCD screen.
Then press the + or – Value buttons to enlarge or reduce your document to fit on the
paper you loaded. Or select Auto Fit Page to have the EPSON Stylus CX5400
automatically determine the necessary reduction or enlargement.
To reduce or enlarge by a precise percentage, press the right Menu button until you
see Zoom In/Out on the LCD screen. Then press the + or – Value buttons to select a
percentage of the scanned image for the resulting print.
Note: If you select Auto Fit Page as the Reduce/Enlarge setting to copy a
document with white or very light colored edges, the original size may not be
recognized correctly, creating an incorrect size copy. If this occurs, select 100%
as the Reduce/Enlarge setting and use the Zoom In/Out setting to adjust the size
of your copy.

Copying With the Computer
Follow these steps to use EPSON Smart PanelTM to copy with your computer.
Note: Some features, such as PhotoEnhanceTM and Sepia, are only available
when copying from the computer.

1. Make sure the EPSON Stylus CX5400 is on and paper is loaded in the sheet
feeder.
2. Place the document face-down on the glass, in the top, left corner as described in
Copying Without the Computer.
3. Select the EPSON Smart Panel icon on your desktop or press the Scan button
on the EPSON Stylus CX5400 to open Smart Panel. (To change the application
assigned to the Scan button, see One-Touch Scanning.)
Note: You can also open EPSON Smart Panel in Windows by selecting Start >
All Programs or Programs > EPSON Smart Panel > EPSON Smart Panel.
On Macintosh, you can open Smart Panel from the Applications folder.
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4. Click the Smart Panel Copy Center button. You see the Copy Settings screen.

Cancel button
Stop button

Copy button

Note: The screens may appear slightly different on Macintosh systems.

5. Adjust any of the following copy settings:
■

Source Type: Choose Photo & Text, Photo, or Text, based on the content

of your original.
■

Size: Choose the setting based on the size of your original and your copy, or
click Manual and enter a percentage to reduce or enlarge your copy by a

specific amount.
■

Lighten/Darken: Adjust this by clicking the up and down arrows.

■

Number of Copies: Enter a number or click the up and down arrows.

Note: Press the
made.
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Cancel button if you need to cancel any setting changes you

6. Click the Device Settings button on the right to check your input and output
devices:

You should see your EPSON Stylus CX5400 as the input and output device.
Click Settings to change the displayed print settings (such as a different Media
Type setting, if you loaded special paper) or select additional options. See these
sections for details:
■

Printing With Windows

■

Printing With Macintosh OS 8.6 to 9.x

■

Printing With Macintosh OS X

7. Click the Image Adjust button on the right to enhance your image or add
effects:
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■

Enable or disable the automatic document enhancement feature

■

Add a sepia, blue, or black and white filter

■

Adjust brightness, contrast, or saturation levels

8. Click the

Copy button to start copying.

If you need to stop copying in progress, click the

Stop button.

Note: For more information on Smart Panel copy settings, see the on-screen
Smart Panel User Guide or click ? on the main Smart Panel window.
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Printing With Windows
■

Printing From an Application

■

Selecting Default Settings

■

Customizing Windows Print Settings

■

Printing BorderFree Photos (Windows)

Printing From an Application
After you create a document in a software program, follow these steps to print it using
the basic printer settings:
1. From the File menu, click Print. You see a Print window like this one:
Check for your
printer name here
Click here to
open your printer
software

2. Make sure EPSON Stylus CX5400 is selected.
3. Click the Preferences or Properties button.
(If you see a Setup, Printer, or Options button, click it. Then click Preferences
or Properties on the next screen.)
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4. Select the following settings on the Main tab in your printer settings window:
Select the type of document you’re printing:
Draft: For rough drafts with
reduced print quality

Select your paper type
(see Selecting Your
Paper Type)
Select your paper
size
Select your document
or image orientation

Click OK

Text: For text-only
documents (like letters) with
good print quality
Text & Image: For
documents with text and
images with higher print
quality
Photo: For photos and
graphics with good print
quality and speed
Best Photo: For photos or
graphics with high print
quality

Note: For more information about printer settings, click the ? or Help button.
The Quality Type settings on this screen give you the best combination of quality
and print speed for most prints. For the highest print quality (Photo RPM™) on
selected papers, click the Advanced button on the Main tab. Then see
Customizing Windows Print Settings for instructions on selecting Photo RPM.

5. You return to the Print window. Click OK or Print to start printing.
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During printing, this window appears and shows the progress of your print job. You
can use the buttons to cancel, pause, or resume printing. You can also see how much
ink you have left.

Click to cancel printing
Click to pause or
resume printing

Selecting Default Settings
Your printer settings apply only to the program you’re currently using. If you want,
you can change the Windows default printer settings for all your programs.
1. Right-click the

printer icon in the lower right corner of your screen (taskbar).

2. Select Printer Settings. You see the window shown in Printing From an
Application.
3. Select the default settings you want for all your applications, then click OK.
You can still change the printer settings in your program, if necessary.

Customizing Windows Print Settings
You can use advanced settings for color matching, printing at a higher resolution, or
selecting a variety of special effects and layouts.
1. On the Main tab, click the Advanced button in the bottom right corner of the
window. The Basic settings change to the Advanced settings.
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2. Select the following advanced settings as necessary:

Select Paper & Quality
options as necessary
Click here to select
Photo RPM (5760 × 1440 dpi)
for the best print quality on
certain paper types

Select Print Options as
necessary
Click here to select Black
Ink Only printing
Select a color management
method
To choose No Color
Adjustment, click ICM first

Note: For the highest print quality, select Photo RPM. Please note that printing
will take longer in this mode.
For more information about advanced settings, or instructions on saving them as
a group so you can reuse them later, click the Help or ? button. If you want to use
the Advanced screen each time you access your printer settings, select the
Show this screen first checkbox.

3. Once you’ve finished selecting advanced settings, you can:
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■

Click OK to save your settings, return to the Print window, and print.

■

Click the Basic button to return to the Basic settings.

■

Click the Page Layout tab and continue with step 4 to select layout options.

4. Select the following page layout settings as necessary:
Select image or
document position
options here

Select multi-page
document options here
and here

Select image or
document resizing
options here; these
affect only your printed
image

To print a large image
on several sheets to
make a poster, select
settings here

Add a watermark to
your printed page here

Note: For more information on page layout settings, click the Help or ? button.

5. Click OK to save your settings, return to the Print window, and print.

Printing BorderFree Photos (Windows)
You can print your photos with no margins, extending the image all the way to the
edges of the page. Although BorderFree printing is a bit slower (especially near the
edges), you get beautiful snapshots or enlargements, without trimming.
BorderFree printing supports the following paper types and sizes:

EPSON paper name

Sizes

Menu setting

Type or Media
Type setting

Photo Paper or Glossy Photo Paper

4×6

Photo Paper

Glossy Photo Paper

Matte Paper Heavyweight

8 × 10

Matte Paper HW

Matte Paper Heavyweight

DURABrite Ink Glossy Photo Paper

4×6

DB Photo Paper

DURABrite Ink
Glossy Photo Paper

Note: For instructions on loading special paper, see Special Papers.
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You can print BorderFree photos using the EPSON Stylus CX5400 menus and
buttons or your printer software.
To use the menus and buttons, follow the instructions in Copying Without the
Computer and select Border Free as the Copy Mode setting, as described in
Changing Copy Settings.
To use your printer software, follow these steps:
1. Start your printing application and open your photo file.
2. Access the printer settings window (see Printing From an Application).
3. Select Photo or Best Photo as the Quality Type setting.
4. Select your paper type as the Type setting.
5. Click the Borderless checkbox, then select your paper size as the Size setting.

6. Select Portrait or Landscape as the Orientation setting.
7. Click OK.
8. Click OK or Print.
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Printing With Macintosh OS X
■

Customizing Print Settings (Mac OS X)

■

Printing BorderFree Photos (Macintosh OS X)

If you’re using an OS X compatible printing application, follow the steps below to
print a document. (If you’re using an application that’s compatible only with
Macintosh Classic mode, follow the steps in Printing With Macintosh OS 8.6 to 9.x
instead.)
Before you begin, make sure you added your printer to Print Center as described on
the Start Here sheet.
1. From the File menu, select Page Setup.
2. Select the following Page Setup settings as necessary:

Select CX5400 from
the Format for
pop-up menu

Select the Paper Size,
Orientation, and any
other settings you
want to use

If you want to print a borderless photo, follow the instructions in Printing
BorderFree Photos (Macintosh OS X).
3. When you’re finished, click OK.
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4. Select Print from the File menu. You see a screen like this:

Click here and
select Print
Settings

5. Make sure to select the same option in the Printer pull-down menu as you
selected in the Page Setup window. For example, if you selected Stylus CX5400
(Sheet Feeder - Borderless), be sure to choose that exact setting in the Print
window too.

Click here and
select Print
Settings

6. Select Print Settings from the pull-down menu.
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Select the same
option as the
Page Setup
window

7. Select the following Print Settings as necessary:
Select your paper type
(see Selecting Your Paper
Type)
Select Color (for color
documents and black and
white photographs) or
Black for black text
documents
Select Automatic mode
Select Quality, Speed, or
an in-between setting

Note: The Quality setting on this screen gives you the best combination of quality
and print speed for most prints. For the highest print quality on selected papers,
click the Advanced button and see Customizing Print Settings (Mac OS X). For
more information about printer settings, click Help.

8. You can also choose other print settings by selecting these options in the
pull-down menu:
■

Copies & Pages, to select the number of copies or a page range

■

Layout, to select page layout options

■

Output Options, to save your print job as a PDF file

■

Color Management, to select ColorSync,® adjust the color controls, change

the gamma setting, or turn off color adjustments by the printer software
■

Summary, to view a list of all your selections

9. Click Print.
10. To monitor the progress of your print job, click the
appears in the dock on the bottom of your desktop.

Print Center icon when it
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11. Double-click your printer in the Printer List window. You see a screen like this:

12. Monitor the progress of your print job or do one of the following:
■

Click the print job, then click Delete to delete the job

■

Click the print job, then click Hold to pause printing

■

Click a print job marked “Hold” and click Resume to resume printing

■

If multiple print jobs are listed, click a print job, then click the Priority arrow
as necessary to reorder the jobs

13. When you’re finished, close Print Center.

Customizing Print Settings (Mac OS X)
You can use advanced settings for color matching, printing at a higher resolution, or
selecting a variety of special effects and layouts.
1. Open the Print Settings window and click Advanced.
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2. Select these advanced settings as necessary:

Click here to select Photo RPM
(5760 × 1440 dpi) for the best print
quality on certain paper types

Select various print options here
To select color management
settings, select Color
Management from the Print
Settings pull-down menu

Note: For the highest print quality, select Photo RPM. Please note that printing
will take longer in this mode.
For more information on advanced settings, or instructions on saving them as a
group so you can reuse them later, click Help.

3. Click Print.

Printing BorderFree Photos (Macintosh OS X)
You can print your photos with no margins, extending the image all the way to the
edges of the page. Although BorderFree printing is a bit slower (especially near the
edges), you get beautiful snapshots or enlargements, without trimming.
BorderFree printing supports the following paper types and sizes:

EPSON paper name

Sizes

Menu setting

Type or Media
Type setting

Photo Paper or Glossy Photo Paper

4×6

Photo Paper

Glossy Photo Paper
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Type or Media
Type setting

EPSON paper name

Sizes

Menu setting

Matte Paper Heavyweight

8 × 10

Matte Paper HW

Matte Paper Heavyweight

DURABrite Ink Glossy Photo Paper

4×6

DB Photo Paper

DURABrite Ink
Glossy Photo Paper

Note: For instructions on loading special paper, see Special Papers.

You can print BorderFree photos using the menus and buttons on the Stylus CX or
your printer software.
To use the menus and buttons, follow the instructions in Copying Without the
Computer and select Border Free as the Copy Mode setting, as described in
Changing Copy Settings.
To use your printer software, follow these steps:
1. Start your printing application and open your photo file.
2. Click File > Page Setup.
3. Select Stylus CX5400 (Sheet Feeder - Borderless) from the Format for
pull-down menu.

Select Stylus CX5400 (Sheet
Feeder - Borderless)

4. Select your paper size as the Paper Size setting.
5. If necessary, select your page orientation:
for documents that are longer than
they are wide, or
or
for documents that are wider than they are long.
6. Click OK.
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7. Click File > Print.
8. Select Print Settings from the pull-down menu.
9. Select Stylus CX5400 (Sheet Feeder - BorderFree) from the Printer
pull-down menu. Always check to make sure you selected the same setting you
chose in the Page Setup window.
Select Stylus CX5400 (Sheet
Feeder - Borderless)

Select your BorderFree
paper type

10. Select your paper type as the Media Type setting.
11. Click Print.

Printing With Macintosh OS 8.6 to 9.x
■

Customizing Print Settings (Mac OS 8.6 to 9.x)

■

Printing BorderFree Photos (Mac OS 8.6 to 9.x)
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Before you begin, make sure you selected your printer in the Chooser as described on
the Start Here sheet.
1. From the File menu, select Page Setup. Select the following settings:
Make sure you see CX5400

Select your paper size

Select the orientation of
your document or image

2. Click OK to close the Page Setup window.
3. From the File menu, select Print. Select the following settings:
Select your paper type
(see Selecting Your Paper
Type)
Select Color (for color
documents and black and
white photographs) or
Black (for black text
documents)
Select Automatic mode
Select Quality, Speed, or
an in-between setting

Note: The Quality setting on this screen gives you the best combination of quality
and print speed for most prints. For the highest print quality (Photo RPM) on
selected papers, click Custom and click the Advanced button. Then see
Customizing Print Settings (Mac OS 8.6 to 9.x) for instructions on selecting Photo
RPM.
For more information about printer settings, click the ? button.

4. You can also do the following:
■
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Click
to reduce/enlarge your printed image, print multi-page layouts, or
add a watermark.

■

Click

■

Click

■

Click

to control background printing and schedule print jobs.
, then click Preview to preview your printout.
to check your ink levels.

5. Click Print.
6. If you turned on background printing, you can select EPSON Monitor IV from
the Application menu in the upper right corner of the screen. You see the EPSON
Monitor window:
Select your print job,
then click here to
cancel printing

Click to check
ink levels

Note: If you’re not using background printing and you need to cancel printing,
hold down the key and press the . (period) key.
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Customizing Print Settings (Mac OS 8.6 to 9.x)
You can use advanced settings for color matching, printing at a higher resolution, or
selecting a variety of special effects and layouts.
1. To access advanced settings, click Custom, then click Advanced.

Click Custom, then click Advanced

2. Select these advanced settings as necessary:

Click here to select
Photo RPM (5760 × 1440 dpi)
for the best print quality on
certain paper types
Select various print
options here
Select color management
settings here

Note: For the highest print quality, select Photo RPM. Please note that printing
will take longer in this mode.
For more information on advanced settings, or instructions on saving them as a
group so you can reuse them later, click ?.

3. Click OK to save your settings, then click Print.
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Printing BorderFree Photos (Mac OS 8.6 to 9.x)
You can print your photos with no margins, extending the image all the way to the
edges of the page. Although BorderFree printing is a bit slower (especially near the
edges), you get beautiful snapshots or enlargements, without trimming.
BorderFree printing supports the following paper types and sizes:

EPSON paper name

Sizes

Menu setting

Type or Media
Type setting

Photo Paper or Glossy Photo Paper

4×6

Photo Paper

Glossy Photo Paper

Matte Paper Heavyweight

8 × 10

Matte Paper HW

Matte Paper Heavyweight

DURABrite Ink Glossy Photo Paper

4×6

DB Photo Paper

DURABrite Ink
Glossy Photo Paper

Note: For instructions on loading special paper, see Special Papers.

You can print BorderFree photos using the menus and buttons on the Stylus CX or
your printer software.
To use the menus and buttons, follow the instructions in Copying Without the
Computer and select Border Free as the Copy Mode setting, as described in
Changing Copy Settings.
To use your printer software, follow these steps:
1. Start your printing application and open your photo file.
2. Click File > Page Setup.
3. Click the Borderless checkbox, then select your paper size as the Paper Size
setting.
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4. Select Portrait or Landscape as the Orientation setting.
5. Click OK.
6. Click File > Print.
7. Select your paper type as the Media Type setting.
8. Click Print.
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Selecting Your Paper Type
Select the correct Type or Media Type setting so your printer knows what kind of
paper you’re using and adjusts the ink coverage accordingly.

For this paper

Select this Type or Media Type
setting

Plain paper sheets or envelopes

Plain Paper/Bright White Paper

EPSON Premium Bright White Paper
EPSON Photo Quality Ink Jet Paper

Matte Paper - Heavyweight

EPSON Photo Quality Ink Jet Cards
EPSON Matte Paper Heavyweight
EPSON Double-Sided Matte Paper
EPSON DURABrite Ink Glossy Photo Paper

DURABrite Ink Glossy Photo Paper

EPSON Photo Paper

Glossy Photo Paper

EPSON Glossy Photo Paper
EPSON Ink Jet Transparencies

Ink Jet Transparencies
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Scanning
■

Placing Your Original Document

■

Using EPSON Smart Panel

■

Scanning to a File

■

One-Touch Scanning

■

Advanced Scanning With EPSON Scan

Placing Your Original Document
1. Open the scanner lid.
2. Place your document face-down on the glass, in the upper left corner. Move your
document about 0.1 inch from the top and side edge so your entire document is
scanned.

Move the document
in about 0.1 inch
from the edges

3. Close the scanner lid.
Note: If you place your document against the guides, the edges next to the
guides won’t be scanned.
If you need to scan a thick document, such as a book, you can remove the
scanner lid to scan. Gently press down the original to keep it flat on the document
table. Be sure to replace the scanner lid when you’re finished.
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Using EPSON Smart Panel
EPSON Smart Panel is an easy, step-by-step interface for scanning, copying, and
more. You can use it to launch a variety of programs on your computer, as described
below, or use it with the EPSON Stylus CX5400 Scan button for automatic
scanning, as described in Scanning to a File.

Smart Panel Features

Description
Scans and prints photos in various sizes and layouts.
Includes Color Restoration.

RePrint Photos
Scan an image or document directly to a file on your hard
drive.
Scan and Save
Scans and prints a document with the power and flexibility
of a conventional photocopier.
Copy Center
When you install your own fax software, scans your image
or document into your PC fax utility.
Copy to Fax
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Smart Panel Features

Description
Scans text documents and converts them into editable text
files on your computer with great accuracy.

Edit Text

Photo Projects

Scans a photo into ArcSoft® PhotoImpressionTM where you
can edit, retouch, enhance, and print it with templates,
frames, and borders.
Scans an image or document and lets you choose which
program it launches for handling the scanned file.

Scan to Application
Scans an image or document and attaches it to an e-mail so
you can send it right away.
Scan to E-mail
Scans an image and uploads it to EPSON’s photo-sharing
web site.
EPSON Photo Site

For details on using all the Smart Panel features, click the ? button in Smart Panel or
see the on-screen Smart Panel User Guide.

Scanning to a File
1. Place the document face-down on the glass, in the top, left corner as described in
Placing Your Original Document.
2. Select the
EPSON Smart Panel icon on your desktop or press the Scan
button on the EPSON Stylus CX5400 to open Smart Panel. (To change the
application assigned to the Scan button, see One-Touch Scanning.)
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Note: You can also open EPSON Smart Panel in Windows by selecting Start >
All Programs or Programs > EPSON Smart Panel > EPSON Smart Panel.
On Macintosh, you can open Smart Panel from the Applications folder.

3. Click the Scan and Save button. Smart Panel starts EPSON Scan, which
automatically scans your document.
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4. In the following screen, double-click the photo thumbnail to see an enlarged
preview and make sure it scanned properly. To rename the image, click the file
name below it and type in a new name.

Click here
to rename
file

Click
Next

5. Click Next.

6. Select a file location and file type, then click Save to save your file to the location
you selected. It’s ready to open, print, e-mail, or use as you like.
Note: For instructions on scanning with the other Smart Panel options, select ? in
the Smart Panel window.
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One-Touch Scanning
You can use your Scan button to automatically scan a photo into an imaging
application, scan a document to convert it into editable text, or scan to e-mail, print,
or fax.
The following example explains how to set up the Scan button so you can scan files
to e-mail.
1. Place the document face-down on the glass, in the top, left corner as described in
Placing Your Original Document.
2. Select the
EPSON Smart Panel icon on your desktop or press the Scan
button on the EPSON Stylus CX5400.
Note: You can also open EPSON Smart Panel in Windows by selecting Start >
All Programs or Programs > EPSON Smart Panel > EPSON Smart Panel.
On Macintosh, you can open Smart Panel from the Applications folder.

Scan button
start list

3. Select Scan to E-mail in the Scan button start list in the bottom left corner of the
Smart Panel window. Then exit Smart Panel.
4. Press the Scan button on the EPSON Stylus CX5400. Smart Panel starts and
EPSON Scan automatically scans your document.
5. Complete your e-mail by entering the address and subject, and adding a message,
if you like. Then send your e-mail.

42

6. To continue one-touch scanning to e-mail, just press the Scan button and repeat
step 5. To change the program that opens when you press the Scan button, select
a different option in the Scan button start list on the Smart Panel window, as
described in step 3.

Advanced Scanning With EPSON Scan
EPSON Scan provides three scanning modes for progressive levels of control over
your scanned image:
■

Full Auto Mode makes scanning quick and easy, with automatic image type and

resolution settings.
■

Home Mode provides a simple screen giving you automatic image adjustments,

previewing and cropping capability, and preset configurations for various types of
scans. Includes Color Restoration.
■

Professional Mode lets you manually configure advanced image settings,

including Color Restoration.
Note: EPSON Scan starts in the mode you used last, but you can change the
mode at any time.

You can scan from any TWAIN-compliant application—such as Adobe®
Photoshop®—using EPSON Scan. Or you can start EPSON Scan directly from your
computer.
1. Place your document or photo face-down on the glass, in the top, left corner as
described in Placing Your Original Document. You can also place additional
small documents or photos and scan them at the same time.
2. Start your application, then go to step 3.
Or do one of the following:
■

On Macintosh, double-click EPSON Scan in the Applications folder and go
to step 4.

■

In Windows, select Start > All Programs or Programs > EPSON Scan and
go to step 4.
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3. Open the File menu and choose Import or Acquire and select EPSON Stylus
CX5400.

Click to start
EPSON Scan

EPSON Scan starts previewing your image in Full Auto Mode.
4. To switch modes, click the Pause button at the bottom of the screen.

Click Pause

5. Select Home Mode or Professional Mode from the Mode pull-down menu at
the top of the screen.
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EPSON Scan previews your image and displays the screen for the mode you
chose.

Home Mode

Professional Mode
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6. If you don’t see an automatic preview of your scan to the right of the EPSON
Scan window, click the Preview button. After a moment, your image appears in
the Preview window.

Click the Auto
Detect icon

Note: If you placed more than one document or photo on the document table,
you see multiple images in the preview window.

7. Click the
Auto Detect icon to crop the scan to the edges of your image,
creating a movable outline called a “marquee.” If you’re scanning more than one
image, the marquee surrounds all of them. (For information on adjusting the
marquee, see Adjusting the Scan Area (Marquee).)
Note: If your Home Mode preview image has a blue box around it, you’re
previewing in Thumbnail mode and can’t create a marquee. Click the arrow
beside the Preview button and select Normal from the menu that appears. Click
the Preview button again to preview in normal mode.

8. Choose Document Type, Image Type, and Destination settings that match
the type of image you’re scanning and the way you want to print or view it. (Click
Help on the EPSON Scan screen for detailed information about all the available
settings.)
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Note: The Document Type you select determines the other options that appear in
the EPSON Scan window.

9. Size and adjust your image settings as necessary.
To improve the color of faded photos or negatives, click the Color Restoration
checkbox. If you’re using Professional mode, you may have to scroll to the bottom
of the screen.
10. Click the Scan button.
If you scanned from an application like Photoshop, your scanned image opens in
your application window.
If you opened EPSON Scan from the Applications folder, you see a File Save
Settings window. Type a name for your file in the Prefix box, select a file format
in the Type box, and click OK.

11. Click Close to exit EPSON Scan.
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Adjusting the Scan Area (Marquee)
Once you create a marquee on your preview image, you can use it to crop the area you
want to scan. You can create a marquee on each preview image, if you’re scanning
more than one at a time.

Marquee
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■

To move the entire marquee, click inside the outlined area and drag the marquee
to where you want it.

■

To resize the marquee, click on one of the edges or corners and drag the marquee
to the size you want.

■

To create additional marquees on multiple images, click the next image, then click
the
Duplicate button. Then adjust the marquees as described above.

■

To delete a marquee, click the

■

To start over with a new marquee, click the

Delete button.
Auto Detect button.

Cleaning the Print Head
If your printouts are unexpectedly light, or dots or lines are missing, you may need to
clean the print head. This unclogs the nozzles so they can deliver ink properly. Print
head cleaning uses ink, so clean it only if quality declines.
Note: You can also use a printer software utility to clean the print head right from
your computer. Select the ? or Help button on your printer settings window for
instructions running the print head cleaning utility.

1. Make sure the EPSON Stylus CX5400 is turned on but not printing, and the
Error light is off. (If the Error light is flashing or on, you may need to replace an
ink cartridge; see Replacing an Ink Cartridge for details.)
LCD screen

On button and light
Color Copy button
Error light

Menu buttons

2. Press the left Menu button until you see Head Cleaning on the LCD screen.
3. Press the Color Copy button.
Cleaning takes about 30 seconds, during which the EPSON Stylus CX5400
makes some noise and the On light flashes briefly.
Caution: Never turn off the EPSON Stylus CX5400 while the On light is flashing,
unless the Stylus CX hasn’t moved or made noise for more than 5 minutes.

4. When the On light stops flashing, run a nozzle check to confirm the print head
nozzles are clean.
Make sure paper is loaded. Press the left Menu button until you see Nozzle
Check on the LCD screen, then press the Color Copy button. The nozzle check
pattern prints.
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Note: You can also use a printer software utility to print a nozzle check right from
your computer. Select the ? or Help button on your printer settings window for
instructions on running the nozzle check utility.

5. Examine the nozzle check pattern you print. It should look something like this:

Each line should be complete, with no gaps in the dot pattern. If your printout
looks okay, you’re done.
If you see any gaps in the dot pattern, clean the print head again.
If you don’t see any improvement after cleaning three or four times, check the
solutions in Solving Problems. You can also turn the EPSON Stylus CX5400 off and
wait overnight—this allows any dried ink to soften—and then try cleaning the print
head again.
Caution: When you don’t turn on your EPSON Stylus CX5400 for a long time, the
print quality can decline. It’s a good idea to turn it on at least once a month to
maintain good print quality.

Purchasing Ink Cartridges
Use these EPSON ink cartridges within six months of installing them and before the
expiration date on the package:
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■

Black ink cartridge: T0321

■

Cyan ink cartridge: T0422

■

Magenta ink cartridge: T0423

■

Yellow ink cartridge: T0424

Caution: To ensure good results, use genuine EPSON ink cartridges and do not
refill them. Other products may cause damage to your EPSON Stylus CX5400 not
covered by EPSON’s warranty.

To get the best prints and copies, use genuine EPSON ink and paper. You can
purchase ink cartridges, paper and accessories from your local retailer. Please call
(800) 463-7766 to locate a retailer near you.

Replacing an Ink Cartridge
■

Checking the Ink Supply

■

Ink Cartridge Precautions

■

Removing and Installing Ink Cartridges

Checking the Ink Supply
If the Error light on the EPSON Stylus CX5400 is flashing and you see an ink low or
ink out message on the LCD screen and your computer monitor, you need to replace
one of the cartridges.
When a cartridge is more than six months old, you may need to replace it if printouts
don’t look their best. If the quality doesn’t improve after cleaning and aligning the
print head, you can replace the cartridge.
To check your ink supply, do one of the following:
■

Press the left Menu button until you see Ink Levels. This gives you an
approximate percentage of ink remaining in each cartridge. You can also check the
icon on the LCD screen to see an approximate indication of the ink level.

■

Windows: Double-click the
printer icon in the lower right corner of your
screen. If a cartridge is low on ink, you’ll see a message in the window that appears
on your screen.

■

Macintosh:
OS 8.6 to 9.x: Choose File > Print. Click the

ink icon.
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Menu buttons

OS X: Choose Applications > EPSON Printer Utility > CX5400 > Status
Monitor.

You see a window like this:

Click a cartridge image to display information about the cartridge.

Ink Cartridge Precautions
Warning: Keep ink cartridges out of the reach of children and do not drink the ink.
If ink gets on your hands, wash them thoroughly with soap and water. If ink gets
in your eyes, flush them thoroughly with water.
Caution: To avoid damaging the EPSON Stylus CX5400, never move the print
head by hand.
You cannot print if any ink cartridge is empty. Leave the empty cartridge installed
in the EPSON Stylus CX5400 until you have obtained a replacement. Otherwise
the ink remaining in the print head nozzles may dry out.
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Removing and Installing Ink Cartridges
Be sure you have a new ink cartridge before you begin. Once you start the ink
cartridge replacement procedure, you must complete all the steps in one session.
1. Make sure the EPSON Stylus CX5400 is turned on and not printing. The LCD
screen tells you which ink cartridge is low or empty.
2. If your EPSON Stylus CX5400 is low on ink, press the left Menu button until
you see Change Cartridge, then press the Color Copy button.
If your EPSON Stylus CX5400 is out of ink, press the Color Copy button.
The ink cartridges move to the replacement position.

Color Copy button
Menu buttons

3. Lift up the scanner.
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4. Pinch the tabs on the front and back of the cartridge, lift it out of the printer, and
dispose of it carefully.

5. Before you remove the new cartridge from its package, shake it four or five times.

6. Unwrap the new ink cartridge and lower it into its holder, then press down on the
top of the cartridge until it clicks in place.
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Caution: Don’t touch the green circuit board on the back of the cartridge; you
may inhibit normal operation and printing.

If you need to replace other ink cartridges, repeat steps 4 through 6 before
continuing with step 7.
7. Carefully lower the scanner and press it down until it clicks into place. The
EPSON Stylus CX5400 begins charging the ink delivery system.
The On light flashes and the EPSON Stylus CX5400 makes noise. Charging takes
about 30 seconds. When it’s finished, the On light stops flashing and stays on.
Caution: Never turn off the EPSON Stylus CX5400 while the On light is flashing,
unless the Stylus CX hasn’t moved or made noise for more than 5 minutes.

Aligning the Print Head
If your printouts look grainy or vertical lines appear jagged, you may need to align the
print head.
Note: You can also use a printer software utility to align the print head right from
your computer. Select the ? or Help button on your printer settings window for
instructions running the print head alignment utility.

1. Make sure the EPSON Stylus CX5400 is turned on and not printing, and the
Error light is off.
2. Load a stack of plain, letter-size paper in the sheet feeder.
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3. Press the left Menu button until you see Head Alignment, then press the Color
Copy button to print the first alignment page.
4. On the test page, select the pattern with the two vertical lines most precisely
printed on top of each other. You may need to use a magnifying glass or loupe.

Select one pattern each for rows 1, 2, 3, 4, and 5. (In this example, the best
pattern in each row has been circled.)
5. Press the + or – Value buttons to select the number of the best pattern for the first
row, then press the Color Copy button. Repeat this step for the second, third,
fourth, and fifth rows.
Note: If you select a pattern other than 8 in any row, that pattern becomes
pattern #8 the next time you align the print head.

6. When you’re finished, press the Color Copy button to print the second
alignment sheet.
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7. On the test page, select the pair of horizontal bars with the least noticeable light or
dark band between them. You may need to use a magnifying glass or loupe.

1

2

3

4

5

6

7

8. Press the + or – Value buttons to select the number of the best pattern, then press
the Color Copy button. (In this example, pattern 4 is best.)
9. When you’re finished, press the Color Copy button to print the third alignment
sheet.
10. Repeat steps 7 through 8 to complete the alignment process.
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Cleaning the Stylus CX
To keep your EPSON Stylus CX5400 operating at its best, you should clean it
periodically.
1. Turn off the EPSON Stylus CX5400, unplug the power cord, and disconnect the
USB cable.
2. Remove all the paper from the sheet feeder.
3. Clean the exterior with a soft, damp cloth. (Keep the scanner and scanner lid
closed as you clean.)
4. If necessary, lift up the scanner and clean ink out of the interior with a soft, damp
cloth.

Don’t touch
the metal
carriage shaft

5. Carefully lower the scanner and press it down until it clicks into place.
6. If the document table glass gets dirty, clean it with a soft, dry, lint-free cloth.
Paper towels are not recommended for cleaning the glass. (Be sure there’s no dust
on your document table; it can cause white spots to appear in your scanned
image.)
If the glass is stained with grease or other hard-to-remove material, use a small
amount of glass cleaner on a soft cloth to remove it. Wipe off any remaining
liquid with a dry cloth. Don’t spray glass cleaner onto the document table glass.
Warning: Don’t touch the gears inside the EPSON Stylus CX5400.
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Caution: Be careful not to wipe the metal carriage shaft.
Never use a hard or abrasive brush, or alcohol or thinner for cleaning; they can
damage the printer components, document table, LCD panel, and case.
Don’t get water on the components and don’t spray lubricants or oils inside the
EPSON Stylus CX5400.
Don’t spray glass cleaner onto the document table glass.
Don’t use any cleaning sheets included with special paper; they may jam inside
the EPSON Stylus CX5400.

Transporting the Stylus CX
If you move your EPSON Stylus CX5400 some distance, you need to prepare it for
transportation in its original box or one of a similar size.
Caution: To avoid damage, always leave the ink cartridges installed when
transporting the EPSON Stylus CX5400. Never transport or store the Stylus CX on
its side or in a tilted or upside-down position.

1. Press the On button to turn on the Stylus CX. Wait until the scanner carriage
moves to the home position (toward the left side) and the print head locks in the
far right position. Then turn it off.
2. Open the scanner lid and slide the transportation lock to the

locked position.

3. Unplug the power cord from the electrical outlet. Then disconnect the USB cable.
4. Remove any paper from the sheet feeder and output tray, then remove the paper
support and feeder guard.
5. Close the output tray and its extension.
6. Lift up the scanner.
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7. Tape the ink cartridge holder to the EPSON Stylus CX5400 case.

Tape the ink
cartridge holder
to the case

Caution: Be sure to remove the tape after installing the EPSON Stylus CX5400 in
its new location.

8. Close the scanner carefully until it clicks back into place, then close the output
tray.
9. Repack the EPSON Stylus CX5400 and its attachments in the original box using
the protective materials that came with them.
Keep the EPSON Stylus CX5400 level as you transport it.
After transporting the EPSON Stylus CX5400, remove the tape securing the print
head, unlock the transportation lock, and make a test copy. If you notice a decline in
quality, clean the print head (see Cleaning the Print Head); if output is misaligned,
align the print head (see Aligning the Print Head).
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Solving Problems
■

Checking the LCD Screen

■

Printing a Nozzle Check

■

Setup and Software Installation Problems

■

Printing and Copying Problems

■

Scanning Problems

■

Paper Feed Problems

■

Print Quality Problems

■

Miscellaneous Printing Problems

■

Scan Quality Problems

Checking the LCD Screen
LCD screen

Stop button

On button
and light
Scan button

Color Copy button
Error light

Black and White Copy button

Here is a list of error messages that appear on the LCD screen and what you should do
when you see them.
Error message

Solution

Quality&Paper setting is not
acceptable for B&W copy. Press the
Stop button.

Press the Stop button, then change the
Quality&Paper settings. You can’t copy in
black and white on photo paper.
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Error message

Solution

No XXX ink cartridge – – – >
Press the Color copy button to install
new ink cartridge.

The indicated ink cartridge is not installed.
See Replacing an Ink Cartridge to install a
cartridge.

XXX ink out – – – >
Press the Color copy button to begin
replacing the ink cartridge.

The indicated ink cartridge is out of ink. See
Replacing an Ink Cartridge to replace the
cartridge.

Ink cartridge error – – – >
Press the Color copy button to begin
replacing the ink cartridge.

There is something wrong with the ink
cartridge. See Replacing an Ink Cartridge to
replace the cartridge.

Paper jam or misfeed – – – >
Press the Color copy button and clear
the paper jam by hand if necessary.

Paper is jammed. Press the Color Copy
button to clear the jam. If it is still jammed,
see Paper Feed Problems.

Paper out – – – >
Load paper in Paper tray and press the
Color copy button.

Load paper in the sheet feeder, then press
the Color Copy button to continue printing.

Scanner unit open – – – >
Close the scanner unit.

Carefully close the scanner and press it down
until it clicks securely into place.

Scanner error – – – >
See your documentation and call
service if necessary.

Press the On button to turn off the EPSON
Stylus CX5400. Unlock the transportation
lock, if necessary (see Transporting the
Stylus CX). Turn on your Stylus CX again. If
the error message still appears, contact your
dealer or EPSON as described in Where To
Get Help.

Printer error – – – >
See your documentation and call
service if necessary.

Press the On button to turn off the EPSON
Stylus CX5400, then press the button again
to turn it back on. If the message still
appears, contact your dealer or EPSON as
described in Where To Get Help.

Printing a Nozzle Check
You can print a nozzle check to determine whether a problem comes from the
EPSON Stylus CX5400 or some other source.
1. Make sure letter-size or larger paper is loaded in the sheet feeder.
2. Press the left Menu button on the control panel until you see Nozzle Check.
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3. Press the Color Copy button.
If the check page prints, the problem probably lies in your software settings, the
interface cable, or your computer.
If the check page doesn’t print, you may have a problem with your printer. Try the
suggestions in the following sections.

Setup and Software Installation Problems
Tip: It’s a good idea to check EPSON’s web site periodically for possible updates
to your software. Visit http://support.epson.com and check the section for your
product to see if there is new software available for downloading to your
computer.

The EPSON Stylus CX5400 makes noise after ink cartridge installation.
■

When you install ink cartridges, the Stylus CX must charge its ink delivery
system. Wait until it’s finished (the On light stops flashing) before you turn it off
or it may use excess ink the next time you turn it on.

■

Make sure the ink cartridges are seated securely and no packing material remains
in the Stylus CX. Turn off the Stylus CX, wait a moment, then turn it back on.

You cancelled software installation or connected the EPSON Stylus CX5400
before installing the software.
Your EPSON software may be incorrectly installed. See Uninstalling Your Software.
Make sure you carefully follow the steps on your Start Here sheet when you reinstall
your software. You need to connect the EPSON Stylus CX5400 at the correct time in
the installation process.
You’re having problems installing the software.
■

Make sure your system meets the requirements listed in System Requirements.
Close other programs, including screen savers and virus protectors, and install
again.

■

Make sure that your computer’s Universal Serial Bus (USB) Controller is working
properly in Device Manager; see your Windows help system for details.
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■

If you see an error message or the software doesn’t install correctly on
Windows XP or Windows 2000, you may not have software installation
privileges.

■

If the CX5400 icon doesn’t appear in the Macintosh Chooser, you may have too
many items in the Chooser. Delete any unused items.

■

If you’re printing over a network, see Setting Up Network Printing.

Printing and Copying Problems
Only the On light is on, but nothing prints.
■

Make sure the USB cable is securely connected at both ends.

■

If you’re using a USB hub, try connecting the EPSON Stylus CX5400 directly to
your computer’s USB port instead.

■

Run a nozzle check as described in Printing a Nozzle Check. If the check page
prints, make sure your EPSON Stylus CX5400 software is installed correctly.

■

If you’re printing on a network, you need to set up your EPSON Stylus CX5400
for network printing, as described in Setting Up Network Printing.

It sounds like the EPSON Stylus CX5400 is printing, but nothing prints.
■

The print head nozzles may need cleaning; see Cleaning the Print Head for
instructions.

■

The Stylus CX won’t operate properly if it’s tilted. Place it on a flat, stable surface.

Your EPSON Stylus CX5400 makes noise when you turn it on.
Your Stylus CX is performing routine maintenance.
Printing or copying is too slow.
Make sure your system meets the requirements listed in System Requirements. If
you’re printing a high-resolution image, you need more than the minimum
requirements. You may also need to:
■
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Clear space on your hard disk or run a defragmentation utility.

■

Close open programs that you’re not using.

■

Increase your system’s memory (RAM).

For the fastest printing:
■

Select Draft as the Quality Type (Windows) or set the Quality/Speed slider to
Speed (Macintosh) in your printer software.

■

If your document doesn’t include color, choose Black Ink Only (Windows) or
Black ink (Macintosh) in your printer software (see Printing With Windows,
Printing With Macintosh OS 8.6 to 9.x, or Printing With Macintosh OS X), or
press the B&W Copy button.

■

Turn MicroWeave® off (Macintosh only) and High Speed on in your printer
software.

■

If your EPSON Stylus CX5400 is connected to a USB hub, disconnect any
unused USB devices.

The margins are incorrect.
■

Make sure your paper settings are correct for your paper size. See Printing With
Windows, Printing With Macintosh OS 8.6 to 9.x, or Printing With Macintosh
OS X.

■

Choose the correct margins for your paper size. The margins must be within the
printable area of the page; see Printable Area.

■

Make sure your paper is positioned on the right side of the sheet feeder with the
left edge guide lightly against its left side. Don’t load paper above the arrow on the
left edge guide.

■

Make sure you select the correct Copy mode or settings for the type of document
you are trying to copy. See Changing Copy Settings or Copying With the
Computer.

The printer prints blank pages.
■

Make sure your paper settings are correct for your paper size. See Printing With
Windows, Printing With Macintosh OS 8.6 to 9.x, or Printing With Macintosh
OS X.

■

The print head nozzles may need cleaning; see Cleaning the Print Head for
instructions.
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Scanning Problems
Your system doesn’t recognize the EPSON Stylus CX5400.
Make sure the Stylus CX is connected to your computer and plugged into an electrical
outlet.
The fluorescent lamp isn’t on.
■

The lamp turns off automatically to save power (sleep mode); it comes on when
you start scanning.

■

Make sure the Stylus CX is plugged into a power outlet.

The EPSON Stylus CX5400 doesn’t scan.
■

Wait until the fluorescent lamp stays on (ready for scanning). You may need to
preview your scan to make the lamp come on.

■

If you are using a USB hub, try connecting the EPSON Stylus CX5400 directly
to the computer’s USB port. Use only the USB cable that came with your Stylus
CX.

■

If you see your EPSON Stylus CX5400 in the Windows Control Panel, but you
can’t scan, uninstall and reinstall its software; see Uninstalling Your Software.

The EPSON Stylus CX5400 scanning software doesn’t work properly.
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■

Make sure your system meets the requirements listed in System Requirements.

■

Check if your computer has enough memory for your software. If you’re running
other software at the same time, the computer may not have enough memory. Try
closing any open applications, including screen savers and virus protection
programs.

■

If you’re scanning a large image or scanning at a high resolution, your computer
may not have enough memory to process the image.

■

Check your software installation. If all else fails, uninstall your software, then
reinstall it; see Uninstalling Your Software.

■

If you’re using the Scan button, make sure Smart Panel and your operating
system are set up for scanning using the button. Click the ? button on the Smart
Panel main window for instructions.

Paper Feed Problems
Too many copies are printing.
Make sure that the Copies setting in your printer software and/or program aren’t set
for multiple copies.
Paper doesn’t feed correctly or jams in the EPSON Stylus CX5400.
■

If paper doesn’t feed, remove it from the sheet feeder. Fan the paper, load it
against the right side, and slide the left edge guide against the paper (but not too
tightly).

■

If paper jams, turn off your Stylus CX, lift up the scanner, and remove any paper
that’s inside, including any small pieces that may have torn off. Carefully reload
paper, turn the Stylus CX back on, and press the Color Copy button.
Warning: Clear paper jams by pulling the paper out of the printer in the direction
of the output tray. Never pull the paper out in the direction of the sheet feeder.

Paper doesn’t eject fully or is wrinkled.
■

If the paper doesn’t eject fully, you may have set the wrong paper size. Press the
Color Copy button to eject the paper, then select the correct paper size in your
software.

■

If it’s wrinkled when it ejects, the paper may be damp or too thin. Load new
paper.
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Print Quality Problems
You see banding (light lines) in your printouts or copies.

■

Clean the print head; see Cleaning the Print Head for instructions.

■

Select the correct Type (Windows) or Media Type (Macintosh) setting for the
paper you loaded; see Selecting Your Paper Type.

■

Select a higher print quality and turn off High Speed mode; see Customizing
Windows Print Settings, Customizing Print Settings (Mac OS X), or
Customizing Print Settings (Mac OS 8.6 to 9.x).

■

Make sure the printable side of the paper is face up.

■

The ink cartridges may need replacing; see Replacing an Ink Cartridge.

■

Try using Automatic mode (Macintosh); see Printing With Macintosh OS X or
Printing With Macintosh OS 8.6 to 9.x.

■

Align the print head; see Aligning the Print Head for instructions.

Your printout is blurry or smeared.
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■

Make sure your paper isn’t damp, curled, or loaded face down (the printable side
should be face up). Load new paper face up.

■

Use a support sheet with special paper or try loading your paper one sheet at a
time.

■

Make sure your paper meets the specifications listed in Paper.

■

Align the print head; see Aligning the Print Head for instructions.

■

Use EPSON papers for proper saturation and absorption of genuine EPSON
inks.

Your printout is faint or has gaps.

■

Clean the print head; see Cleaning the Print Head for instructions.

■

The ink cartridges may be old or low on ink; see Replacing an Ink Cartridge.

■

Select the correct Type (Windows) or Media Type (Macintosh) setting for your
paper; see Selecting Your Paper Type.

■

Make sure your paper isn’t damaged, old, dirty, or loaded face down. If it is, load
new paper face up.

Your printout is grainy.
■

Use a higher quality paper or select a higher Quality Type or Print Quality. See
Customizing Windows Print Settings, Customizing Print Settings (Mac OS X) or
Customizing Print Settings (Mac OS 8.6 to 9.x).

■

Align the print head. See Aligning the Print Head for instructions.
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■

Increase the image resolution or print it in a smaller size; see your software
documentation.

■

Make sure the paper thickness lever is set to the correct position. See Envelopes
for instructions.

You see wrong or missing colors.
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■

Make sure Black Ink Only is off (Windows) or Color ink is selected (Macintosh),
even when you’re printing black and white photographs.

■

Clean the print head; see Cleaning the Print Head for instructions.

■

The ink cartridges may be old or low on ink; see Replacing an Ink Cartridge.

■

Try turning off PhotoEnhance. Also check if you’re using a special effect that
alters image colors, like Sepia.

■

Try using Automatic mode (Macintosh); see Printing With Macintosh OS X or
Printing With Macintosh OS 8.6 to 9.x.

■

Try changing the Gamma setting; see Customizing Windows Print Settings,
Customizing Print Settings (Mac OS X) or Customizing Print Settings (Mac OS
8.6 to 9.x).

■

Your printed colors can never exactly match your on-screen colors. However, you
can use a color management system, such as ICM or ColorSync to get as close as
possible. See Customizing Windows Print Settings, Customizing Print Settings
(Mac OS X), or Customizing Print Settings (Mac OS 8.6 to 9.x).

Miscellaneous Printing Problems
You see incorrect characters.
■

Make sure the USB cable is securely connected and that it meets the requirements
listed in System Requirements.

■

Make sure your EPSON Stylus CX5400 is selected in your application, or as the
Windows default printer.

The image size or position is incorrect.
Make sure the paper and/or layout options are set correctly. Click the ? or Help
button on your printer settings window for more information.
The image is inverted, as if viewed in a mirror.
Turn off Mirror Image (Windows) or Flip Horizontal (Macintosh) in the printer
software or the mirror setting in your application software.

Scan Quality Problems
Your scanned image is blurry or distorted.

■

Make sure the document is placed flat against the document table glass. If only
part of the image is blurred, your document may be wrinkled or warped.
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■

Try scanning at a higher resolution, and make sure the correct Image Type,
Exposure, and Gamma setting are selected in EPSON Scan. Click the Help
button on the EPSON Scan window for details.

■

Make sure the document table glass is clean; see Cleaning the Stylus CX.

■

Make sure the EPSON Stylus CX5400 is not tilted or placed on an unstable or
uneven surface.

Your image is too dark.
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■

Try adjusting the brightness with your application software. Also check the
brightness and contrast values of your monitor.

■

The dark area around film is perceived as white, altering the exposure of the
scanning area and causing your scans to appear darker. Set the correct color by
adjusting the border (marquee) so only your image is selected. Click Help in the
EPSON Scan window for details.

■

Change the Display Gamma setting and check the Destination setting in EPSON
Scan. Click Help in the EPSON Scan window for details.

Only part of the image is scanned.

■

The document table has non-readable areas around the edges. Reposition your
document into the readable area, as described in Placing Your Original
Document.

■

If you’re using Full Auto Mode, try using Home Mode. See Advanced Scanning
With EPSON Scan for instructions.

The image does not look the same as the original.
■

Your image and display settings may not be correct for your document type. Click
Help in the EPSON Scan window for details.

■

Your monitor and printer use different technologies to represent colors, so your
printed colors can’t match your screen colors exactly. Try increasing your
monitor’s color palette to view a greater range of colors.

The scanner doesn’t recognize your image type when scanning in Full Auto
mode.
Try scanning the image again. If that doesn’t work, scan in Manual mode. See
Advanced Scanning With EPSON Scan for instructions.
The file size is too big.
Adjust your scan settings. Try selecting a lower resolution (dpi), saving the file in a
different format, or scan only part of the image. 300 dpi is typically an adequate
resolution for images that will be printed.
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The printed image is larger or smaller than the original size.
You have changed the resolution or scaled your image. The image size settings in your
software determine the size of the printed image.
A dotted line appears in the image.
■

If this happens on both your screen and printout, clean the document table as
described in Cleaning the Stylus CX.

■

If the line is just on your printout, you may need to clean your print head, see
Cleaning the Print Head.

Uninstalling Your Software
■

Windows XP or 2000

■

Windows Me or 98

Windows XP or 2000
1. Make sure your EPSON Stylus CX5400 is plugged in and connected to your
computer.
2. In Windows XP, click Start, right-click My Computer, and click Properties.
In Windows 2000, right-click My Computer and click Properties.
3. Select the Hardware tab, then click Device Manager.
4. Click the plus (+) sign next to Other devices or Imaging devices. If a question
(?) mark or an exclamation (!) mark appears next to the EPSON Stylus CX5400
name, right-click the name, and then select Uninstall.
5. Disconnect the USB cable from the EPSON Stylus CX5400.
6. Click Start > Programs or All Programs > EPSON Smart Panel > Uninstall
EPSON Smart Panel and follow the instructions on the screen.
7. When the Smart Panel uninstall is complete, click Start > Control Panel
(Windows XP) or Start > Settings > Control Panel (Windows 2000).
Double-click Add/Remove Programs.
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8. Choose EPSON Copy Utility, then click Add/Remove or Change/Remove
and follow the instructions on the screen. When finished, repeat this step for each
of the following:
■

EPSON Photo Print

■

EPSON Printer Software

■

EPSON Scan

■

ScanToWeb

9. Follow the installation steps on the Start Here sheet to reinstall your software.

Windows Me or 98
1. Disconnect the USB cable from the EPSON Stylus CX5400.
2. Click Start > Programs > EPSON Smart Panel > Uninstall EPSON Smart
Panel and follow the instructions on the screen.
3. Click Start > Settings > Control Panel. Double-click Add/Remove
Programs.
4. Choose EPSON Copy Utility, then click Add/Remove or Change/Remove
and follow the instructions on the screen. When finished, repeat this step for each
of the following:
■

EPSON Photo Print

■

EPSON Printer Software

■

EPSON Scan

■

EPSON USB Printer Devices

■

ScanToWeb

5. Follow the installation steps on the Start Here sheet to reinstall your software.
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Setting Up Network Printing
■

Windows XP and 2000

■

Windows Me and 98

■

Macintosh

Windows XP and 2000
This section tells you how to set up the EPSON Stylus CX5400 so that other
computers on the network can print to it. (The scanning feature cannot be shared
with other computers on the network.)
Note: This section is for small network users only. If you are on a large network
and would like to share the EPSON Stylus CX5400, consult your network
administrator.
To install software programs in Windows 2000, it is necessary to log on as a user
with administrative privileges (a user who belongs to the Administrators group).
To install software programs in Windows XP, it is necessary to log on with a
Computer Administrator account. You cannot install software programs if you log
on as a Limited account user. After you install Windows XP, the user account is
set as a Computer Administrator account.
The images that are provided in the following section pertain to Windows 2000.

First, you need to set up the EPSON Stylus CX5400 as a shared printer on the
computer that it is directly connected to. Then, you must install the EPSON Stylus
CX5400 on each computer that will access it through the network.

Setting Up a Shared Printer
Follow the steps below to configure your computer to share the Stylus CX with other
computers on a network.
1. Click Start > Control Panel or Start > Settings > Control Panel, then click
Printers or Printers and Faxes.
2. Right-click the icon for the EPSON Stylus CX5400, then click Sharing.
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3. Select Shared as or Share this printer, then type a name for the shared printer.
Note: Do not use spaces or hyphens in the shared printer name.

If you want Windows XP or 2000 to automatically download printer drivers to
computers that are running different versions of Windows, click Additional
Drivers and select the environment and the operating systems for the other
computers. Click OK, then insert the printer software CD into the CD-ROM
drive. Select the folder for Windows Me or 98. Click OK to install the additional
drivers.
4. Click OK, or click Close if you installed additional drivers.

Accessing a Network Printer
Follow the steps below to print to the EPSON Stylus CX5400 from other computers
on a network.
Note: The EPSON Stylus CX5400 must be set up as a shared resource on the
computer to which it is directly connected before you can access it from another
computer. For instructions, see Setting Up a Shared Printer.

1. Click Start > Control Panel or Start > Settings > Control Panel, then click
Printers or Printers and Faxes.
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2. Double-click the Add Printer icon. The Add Printer Wizard opens.
3. Click Next.
4. Select Network printer, then click Next.

5. On the next screen, click Next.
6. Double-click the icon of the computer that is directly connected to the EPSON
Stylus CX5400. Then, click the icon for the EPSON Stylus CX5400.
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7. Click Next and follow the on-screen instructions.
Note: Depending on the operating system and the configuration of the computer
to which the EPSON Stylus CX5400 is connected, the Add Printer Wizard may
prompt you to install the printer driver from the printer software CD. In this case,
click the Have Disk button and follow the on-screen instructions.

Windows Me and 98
This section tells you how to set up the EPSON Stylus CX5400 so that other
computers on a network can print to it. (The scanning feature cannot be shared with
other computers on the network.)
First, you need to set up the EPSON Stylus CX5400 as a shared printer on the
computer that it is directly connected to. Then, you must install the EPSON Stylus
CX5400 on each computer that will access it through the network.
Note: This section describes how to use the EPSON Stylus CX5400 as a shared
printer on a network. To connect it directly to a network without setting it up as a
shared printer, consult your network administrator.

Setting Up a Shared Printer
Follow the steps below to configure your computer for printer sharing and to share
the EPSON Stylus CX5400 with other computers on a network.
1. Click Start > Settings > Control Panel.
2. Double-click the Network icon.
3. Click the File and Print Sharing button.
4. Select the I want to be able to allow others to print to my printer(s) check
box and click OK.
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5. In the Network dialog box, click OK.
Note: If a dialog box requesting the insertion of the Windows Me or 98 CD-ROM
appears, insert the CD into the CD-ROM drive and follow the on-screen
instructions.
If a dialog box requesting that you restart your computer appears, do so. Then,
open the Printers folder, and continue from step 7.

6. In the Control Panel, double-click the Printers icon.
7. Right-click the icon for the EPSON Stylus CX5400, then click Share As.
8. Type a name for the shared printer, then click OK.

Accessing a Networked Printer
Follow the steps below to print to the EPSON Stylus CX5400 from other computers
on a network.
Note: The EPSON Stylus CX5400 must be set up as a shared resource on the
computer to which it is directly connected before you can access it from another
computer. For instructions, see Setting Up a Shared Printer.

1. Click Start > Settings > Printers.
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2. Double-click the Add Printer icon. The Add Printer Wizard opens.
3. Click Next.
4. Select Network printer, then click Next.

5. On the next screen, click Browse.
6. Double-click the icon of the computer that the EPSON Stylus CX5400 is directly
connected to. Then, click the icon for the EPSON Stylus CX5400.

7. Click OK and follow the on-screen instructions.
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Macintosh
This section tells you how to set up the EPSON Stylus CX5400 so that you can print
to it on an AppleTalk® network. By setting up the EPSON Stylus CX5400 as a shared
printer, your local printer is connected to the network and can be used by other
computers. (The scanning feature cannot be shared with other computers on the
network.)
Note: This feature is not available with Mac OS X.

First, you need to set up the EPSON Stylus CX5400 as a shared printer on the
Macintosh that it is directly connected to. Then, you must specify the network path
to the EPSON Stylus CX5400 from each computer that will use it, and install the
printer software on those computers.

Setting Up a Shared Printer
To share the EPSON Stylus CX5400 with other computers on an AppleTalk
network, follow the steps below to configure the computer that it is directly
connected to.
1. Turn on the EPSON Stylus CX5400.
2. Choose Chooser from the Apple® menu and click the icon for the EPSON
Stylus CX5400. Then, select the port that the EPSON Stylus CX5400 is
connected to.
3. Click the Setup button. The Printer Sharing Setup dialog box opens.
4. Select the Share this Printer check box, then type the printer name and
password information as necessary.
5. Click OK. The name of the shared printer appears in the port list in the Chooser.
6. Close the Chooser.

Accessing a Networked Printer
Follow the steps in this section to access the EPSON Stylus CX5400 from other
computers on the network.
1. Turn on the EPSON Stylus CX5400.
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2. Install the printer software from the EPSON Stylus CX5400 CD-ROM.
3. Choose Chooser from the Apple menu. Then, click the icon for the EPSON
Stylus CX5400 and select the shared EPSON Stylus CX5400 from the Select a
printer port list.
Note: Only printers that are connected to your current AppleTalk zone are
available.

4. If a password dialog box appears, enter the password for the EPSON Stylus
CX5400, then click OK.
5. Select the appropriate Background Printing radio button to turn background
printing on or off.
6. Close the Chooser.
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Where To Get Help
■

EPSON

■

Other Software Technical Support

EPSON
If you need help with the EPSON Stylus CX5400 or EPSON Scan, see the contact
information below. See Other Software Technical Support if you need help with
other software that came on your EPSON Stylus CX5400 CD-ROM.
EPSON provides technical assistance 24 hours a day through the electronic support
services and automated telephone services listed in the following table:
Service

Access

World Wide
Web

From the Internet, you can reach EPSON Support at
http://support.epson.com. At this site, you can download drivers and
other files, look at product documentation, access troubleshooting
information, and receive technical advice through e-mail.

Automated
Telephone
Services

A variety of automated help services are available 24 hours a day, seven
days a week. To use these services, you must have a touch tone
telephone and call (800) 922-8911. Your EPSON SoundAdviceSM
Express Code is 70465. Use this code to quickly select the EPSON
Stylus CX5400 in SoundAdvice.

To speak to a technical support representative, dial:
■

U.S.: (562) 276-4382, 6 AM to 6 PM, Pacific Time, Monday through Friday

■

Canada: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday through Friday
Toll or long distance charges may apply.

Before you call, please have the following information ready:
■

Product name (EPSON Stylus CX5400)

■

Product serial number (located on the back)

■

Proof of purchase (such as a store receipt) and date of purchase
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■

Computer configuration

■

Description of the problem

To get the best prints and copies, use genuine EPSON ink and paper. You can
purchase ink cartridges, paper and accessories from your local retailer. Please call
(800) 463-7766 to locate a retailer near you.

Other Software Technical Support
Software

Telephone

Fax

Online and E-mail

EPSON Smart Panel

(510) 445-8616

(510) 445-8601

www.newsoftinc.com
contactus@newsoftinc.com

ArcSoft
PhotoImpression

ABBYY® Fine
Reader® Sprint
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(510) 440-9901
8:30 AM to 5:30 PM,
Pacific Time, Monday
through Friday

(510) 440-1270

(510) 226-6719

(510) 226-6069

www.arcsoft.com/
techmain
support@arcsoft.com
www.abbyyusa.com
support@abbyyusa.com

Specifications
■

Printing

■

Paper

■

Mechanical

■

Ink Cartridges

■

Scanning

■

Electrical

■

Environmental

■

Standards and Approvals

■

Interface Specifications
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Printing
Printing method

On-demand ink jet

Nozzle configuration

Monochrome (black) 180 nozzles
Color (cyan, magenta, yellow), 177 nozzles (59 nozzles
per color × 3)

Print resolution

Up to 5760 × 1440 dpi on various papers using Photo
RPM; see Customizing Windows Print Settings,
Customizing Print Settings (Mac OS X), or Customizing
Print Settings (Mac OS 8.6 to 9.x).

Print direction

Bidirectional with logic seeking

Control code

ESC/P® raster
EPSON Remote

Paper
Note: Since the quality of any particular brand or type of paper may be changed
by the manufacturer at any time, EPSON cannot guarantee the quality of any
non-EPSON brand or type of paper. Always test a sample of paper stock before
purchasing large quantities or printing large jobs.
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Single sheets
Size

A4 (8.3 × 11.7 inches)
A5 (5.8 × 8.3 inches)
Letter (8.5 × 11 inches)
Half-letter (5.5 × 8.5 inches)
Legal (8.5 × 14 inches)
Executive (7.3 × 10.5 inches)

Paper type

Plain bond paper, special paper distributed by EPSON
and various types of special media

Thickness (for plain bond
paper)

0.003 to 0.004 inch (0.08 to 0.11 mm)

Weight (for plain bond
paper)

17 lb (64 g/m²) to 24 lb (90 g/m²)

Envelopes
Size

132 × 220 (5.2 × 8.7 inches)
No. 10 (4.1 × 9.5 inches)
DL (4.3× 8.7 inches)
C6 (4.5 × 6.4 inches)

Paper type

Plain bond paper, air mail

Thickness

0.006 to 0.02 inch (0.16 to 0.52 mm)

Weight

12 lb (45 g/m²) to 20 lb (75 g/m²)

Ink Jet Cards
Size

A6 (4.1 × 5.8 inches)

Paper type

Special paper distributed by EPSON
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Ink Jet Transparencies
Size

Letter (8.5 × 11 inches)

Paper type

Special paper distributed by EPSON

Photo Paper and Glossy Photo Paper
Size

Letter (8.5 × 11 inches)
4 × 6 inches (101.6 × 152.4 mm)
A4 (8.3 × 11.7 inches)
Panoramic (8.3 × 23 inches)

Paper type

Special paper distributed by EPSON

Premium Semigloss Photo Paper
Size

Letter (8.5 × 11 inches)

Paper type

Special paper distributed by EPSON

Matte Paper Heavyweight, Double-Sided Matte, and
Archival Matte Paper
Size

Letter (8.5 × 11 inches)
8 × 10 inches (203.2 × 254 mm)

Paper type

Special paper distributed by EPSON

DURABrite Ink Glossy Photo Paper
Size

Letter (8.5 × 11 inches)
4 × 6 inches (101.6 × 152.4 mm)

Paper type

Special paper distributed by EPSON

Note: Poor quality paper may reduce the print quality and cause paper jams or
other problems. If you have print quality problems, switch to a higher grade
paper.
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Do not load curled or folded paper.
Use paper under normal conditions:
Temperature: 59 to 77 °F (15 to 25 °C)
Humidity: 40 to 60% RH

Printable Area
Single sheets or cards

A
B-L

B-R

C
Envelopes

Standard sheets

Sheets copied with
small margin setting

Envelopes

A: top margin

0.12” (3.0 mm)

0.06” (1.5 mm)

0.12” (3.0 mm)

B-L: left margin

0.12” (3.0 mm)

0.06” (1.5 mm)

0.12” (3.0 mm)

B-R: right margin

0.12” (3.0 mm)

0.06” (1.5 mm)

0.12” (3.0 mm)
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C: bottom margin

0.12” (3.0 mm)

0.06” (1.5 mm)

0.78” (20 mm)

Note: Always load paper into the sheet feeder with the short edge first. Load
envelopes flap edge left with the flap side down.
Depending on the type of paper, the print quality may deteriorate in the top and
bottom areas of the printout, or these areas may be smeared.
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Mechanical
Paper feed method

Friction

Paper path

Sheet feeder, top feed

Sheet feeder capacity

About 150 sheets at 24 lb (90 g/m²)

Dimensions

Width: 17.8 inches (453 mm)
Depth: 17.1 inches (434 mm)
Height: 10.0 inches (254 mm)

Weight

19.8 lb (9.0 kg) without the ink cartridges

Ink Cartridges
Black Ink Cartridge (T0321)
Color

Black

Print capacity*

1240 pages/A4 (ISO/IEC 10561 Letter Pattern at 360 dpi)

Temperature

Storage:
–4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)
Transit:
–22 to 140 °F (–30 to 60 °C)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)
Freezing:** 3.2 °F (–16 °C)

Dimensions

Width: 0.8 inches (22.0 mm)
Depth: 2.8 inches (71.2 mm)
Height: 2.6 inches (66.5 mm)

Cyan (T0422), Magenta (T0423), and Yellow (T0424) Ink
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Cartridges
Color

Cyan, magenta, or yellow

Print capacity*

420 pages (A4, 360 dpi, 5% duty each color)

Temperature

Storage:
–4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)
Transit:
–22 to 140 °F (–30 to 60 °C)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)
Freezing:** –0.4 °F (–18 °C)

Dimensions

Width: 0.5 inches (12.7 mm)
Depth: 2.8 inches (71.2 mm)
Height: 2.6 inches (66.5 mm)

* The figure given is based upon continuous printing after ink cartridge replacement. The actual
print capacity may vary, depending on how often you use the print head cleaning function and
how often you turn this product on.
** Ink thaws and is usable after approximately 3 hours at 77 °F (25 °C).

Caution: EPSON recommends the use of original EPSON ink cartridges only.
Other products not manufactured by EPSON may cause damage to this product
not covered by EPSON's warranties.
Do not use an ink cartridge if the date on the package has expired.
Do not refill the ink cartridges. This product calculates the amount of ink
remaining using an IC chip on the ink cartridge. Even if the cartridge is refilled, the
amount of ink remaining will not be recalculated by the IC chip and the amount of
ink available for use will not change.
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Scanning
Scanner type

Flatbed color image scanner

Photoelectric device

Color CCD line sensor

Effective pixels

10,200 × 14,040 pixels at 1200 dpi, 100%

Document size

8.5 × 11.7” (216 × 297 mm)
Letter or A4 size (reading area selectable with software)

Scanning resolution

1200 dpi (main)
2400 dpi (sub)

Output resolution

50 to 4800 dpi (adjustable in one-dpi increments), 7200
dpi, and 9600 dpi

Color separation

RGB color filters on CCD

Image data

16 bits per pixel per color internal
8 bits per pixel per color external

Gamma correction

User defined 2 level

Interface

USB

Light source

White cold cathode fluorescent lamp

Reliability

30,000 cycles of carriage movements (main unit MCBF)

Lamp

10,000-hour life

Electrical
Input voltage range

108 to 132V

Rated frequency range

50 to 60 Hz

Input frequency range

49.5 to 60.5 Hz

Rated current

0.5 A

Power consumption

Approx. 23 W (ISO10560 Letter pattern)
Approx. 6.0 W in sleep mode
Approx. 0.6 W in power-off mode
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Note: Check the label on the back of this product for the voltage information.

Environmental
Temperature

Operation: 50 to 95 °F (10 to 35 °C)
Storage: –4 to 140 °F (–20 to 60 °C)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Humidity

Operation: 20 to 80% RH
Storage in shipping container: 5 to 85% RH
(without condensation)

Standards and Approvals
Safety

UL 1950
CSA C22.2 No.950

EMC

FCC part 15 Subpart B class B
CSA C108.8 Class B

Interface Specifications
This product’s built-in USB interface is based on the standards specified in the
Universal Serial Bus Specifications Revision 1.1 and the Universal Serial Bus Device
Class Definition for Printing Devices Version 1.1. This interface has the following
characteristics:
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Standard

Based on Universal Serial Bus Specifications Revision 1.1,
Universal Serial Bus Device Class Definition for Printing
Devices Version 1.1

Bit rate

12 Mbps (full speed device)

Data encoding

NRZI

Connector

USB Series B

Recommended
cable length

6.6 feet (2 meters)

System Requirements
■

Windows System Requirements

■

Macintosh System Requirements

Windows System Requirements
To use your EPSON Stylus CX5400 and its software, your system should have:
■

A Microsoft® Windows® compatible PC with a Pentium® 300 MHz or better
processor

■

Microsoft Windows XP, Windows 2000, Windows Me, or Windows 98

■

128MB RAM (256MB or more of RAM recommended)

■

VGA monitor or better with at least 256 colors

■

At least 200MB of free hard disk space (300MB or more recommended)

■

CD-ROM or DVD drive for installing the software

■

Windows-compliant USB port and the USB cable that came with your EPSON
Stylus CX5400.

Macintosh System Requirements
To use your EPSON Stylus CX5400 and its software, your system should have:
■

An Apple® iMacTM series, Power Macintosh® G3 or G4, PowerBook,® iBook,TM
or eMacTM

■

Mac® OS 8.6 through OS 9.x or OS X 10.2.x (Mac OS 9.1 or later
recommended)

■

At least 128MB of available RAM (256MB or more recommended)
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■

At least 200MB of free hard disk space (300MB or more recommended)

■

VGA monitor or better with at least 256 colors

■

CD-ROM or DVD drive for installing the printer software

■

The USB cable that came with your Stylus CX.

Important Safety Instructions
Ink Cartridge Safety Instructions
LCD Panel Safety Instructions
Before using your EPSON Stylus CX5400, read and follow these safety instructions:
■

Be sure to follow all warnings and instructions marked on the Stylus CX5400.

■

Use only the type of power source indicated on the Stylus CX5400 label.

■

Connect all equipment to properly grounded power outlets. Avoid using outlets
on the same circuit as air control systems or other high-load devices that regularly
switch on and off.

■

Place the Stylus CX5400 near a wall outlet where the plug can be easily
unplugged.
Placez l’imprimante près d’une prise de contacte où la fiche peut être débranchée
facilement.

■

Do not let the power cord become damaged or frayed.

■

If you use an extension cord with the Stylus CX5400, make sure the total ampere
rating of the devices plugged into the extension cord does not exceed the cord’s
ampere rating. Also, make sure the total ampere rating of all devices plugged into
the wall outlet does not exceed the wall outlet’s ampere rating.

■

Avoid electrical outlets controlled by wall switches or automatic timers.

■

Keep your Stylus CX5400 and computer system away from potential sources of
electromagnetic interference, such as loudspeakers or cordless telephone base
units.

■

Avoid locations that are subject to rapid changes in heat or humidity, shocks or
vibrations, or dust.

■

Leave enough room around the Stylus CX5400 for sufficient ventilation.

■

Do not place the Stylus CX5400 near a radiator or heating vent or in direct
sunlight.
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■

Place the Stylus CX5400 on a flat, stable surface that extends beyond its base in all
directions. It will not operate properly if it is tilted or at an angle. Leave enough
space in front of the Stylus CX5400 (at least 9 inches) so it doesn’t tip forward
and fall off of the work surface.

■

Turn off and unplug the Stylus CX5400 before cleaning. Clean with a damp
cloth only. Do not spill liquid on it.

■

Always turn the Stylus CX5400 off using the On button. Don’t turn off
the power using a switch on a power strip or unplug the Stylus CX5400 until the
On light is off.

■

Do not block or cover openings in the Stylus CX5400 case or insert objects
through the slots.

■

Except as specifically explained in your documentation, do not attempt to service
the Stylus CX5400 yourself.

■

Unplug the Stylus CX5400 and refer servicing to qualified service personnel
under the following conditions: if the power cord or plug is damaged; if liquid has
entered the product; if the product has been dropped or the case damaged; if the
product does not operate normally or exhibits a distinct change in performance.
Adjust only those controls that are covered by the operating instructions.

■

Before transporting the Stylus CX5400, make sure the print head is capped in the
far right position, the ink cartridges are in place, and the scanner is secured by the
transportation lock.

■

This product includes a lamp component that contains mercury. Please consult
your state and local regulations regarding disposal or recycling. Do not put in the
trash.

Ink Cartridge Safety Instructions
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■

Leave the ink cartridges installed. Removing the cartridges can dehydrate the print
head and may prevent the EPSON Stylus CX5200 from printing.

■

Keep ink cartridges out of the reach of children and do not drink the ink.

■

Be careful when you handle used ink cartridges; there may be ink remaining
around the ink supply port. If ink gets on your skin, wash it off with soap and
water. If it gets in your eyes, flush them immediately with water.

■

Do not put your hand inside the Stylus CX5400 or touch the cartridge during
printing.

■

Do not move the print head by hand; otherwise you may damage the
Stylus CX5400.

■

Install the ink cartridge immediately after you remove it from its package. Leaving
the cartridge unpacked for a long time before use may result in reduced print
quality.

■

Do not use an ink cartridge beyond the date printed on the cartridge package. For
best results, use up the ink cartridges within six months of first installing them.

■

Store ink cartridges in a cool, dark place. Store each ink cartridge so that the
bottom of its package faces down.

■

After bringing an ink cartridge inside from a cold storage site, allow it to warm up
at room temperature for at least three hours before using it.

■

Do not remove or tear the label on an ink cartridge; this can cause leakage.

■

Do not dismantle the ink cartridges or try to refill them. This could result in
damage to the print head.

■

Do not touch the green IC chip on the side of the cartridge. This may affect
normal operation and printing.

■

If you remove an ink cartridge for later use, protect the ink supply area from dirt
and dust and store it in the same environment as the Stylus CX5400. Note that
there is a valve in the ink supply port, making covers or plugs unnecessary, but
care is needed to prevent the ink from staining items that the cartridge touches.
Do not touch the ink cartridge ink supply port or surrounding area.

LCD Panel Safety Instructions
■

Use only a dry soft cloth to clean the LCD display. Don’t use liquid or chemical
cleaners.

■

If the LCD display is damaged, contact your dealer.

■

If LCD solution gets on your skin, wash it off thoroughly with soap and water. If
it gets in your eyes, flush them immediately with water.
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Legal Notices
■

FCC Compliance Statement

■

Declaration of Conformity

■

ENERGY STAR Compliance

■

Copyright Notice

■

Trademarks

FCC Compliance Statement
For United States Users

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference
to radio or television reception. However, there is no guarantee that interference will
not occur in a particular installation. If this equipment does cause interference to
radio and television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the
following measures:
■

Reorient or relocate the receiving antenna.

■

Increase the separation between the equipment and receiver.

■

Connect the equipment into an outlet on a circuit different from that to which
the receiver is connected.

■

Consult the dealer or an experienced radio/TV technician for help.
WARNING

The connection of a non-shielded equipment interface cable to this equipment will
invalidate the FCC Certification of this device and may cause interference levels
which exceed the limits established by the FCC for this equipment. It is the
responsibility of the user to obtain and use a shielded equipment interface cable with
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this device. If this equipment has more than one interface connector, do not leave
cables connected to unused interfaces. Changes or modifications not expressly
approved by the manufacturer could void the user’s authority to operate the
equipment.
For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.

Declaration of Conformity
According to 47CFR, Part 2 and 15 for: Class B Personal Computers and Peripherals;
and/or CPU Boards and Power Supplies used with Class B Personal Computers:
We:
Located at:

EPSON AMERICA, INC.
MS 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with
47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product
marketed is identical to the representative unit tested and found to be compliant with
the standards. Records maintained continue to reflect the equipment being produced
can be expected to be within the variation accepted, due to quantity production and
testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may
cause undesired operation.
Trade Name:
Type of Product:
Model:

EPSON
Multifunction printer
C141A
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ENERGY STAR Compliance
As an ENERGY STAR Partner, EPSON has determined that this
product meets the ENERGY STAR guidelines for energy
efficiency. The EPA ENERGY STAR office equipment program
is a voluntary partnership with the computer and office
equipment industry to promote the introduction of
energy-efficient personal computers, monitors, printers, fax machines, and copiers in
an effort to reduce air pollution caused by power generation.

Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval
system, or transmitted in any form or by any means, electronic, mechanical,
photocopying, recording, or otherwise, without the prior written permission of
SEIKO EPSON CORPORATION. The information contained herein is designed
only for use with this EPSON product. EPSON is not responsible for any use of this
information as applied to other equipment.
Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the
purchaser of this product or third parties for damages, losses, costs, or expenses
incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this
product or unauthorized modifications, repairs, or alterations to this product, or
(excluding the U.S.) failure to strictly comply with SEIKO EPSON
CORPORATION’s operating and maintenance instructions.
SEIKO EPSON CORPORATION shall not be liable for any damages or problems
arising from the use of any options or any consumable products other than those
designated as Original EPSON Products or EPSON Approved Products by SEIKO
EPSON CORPORATION.

A Note Concerning Responsible Use of Copyrighted
Materials
Digital cameras, scanners, and ink jet printers, like conventional photocopiers and
cameras, can be misused by improper copying or printing of copyrighted material.
While some countries’ laws permit limited copying of copyrighted material in certain
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circumstances, those circumstances may not be as broad as some people assume.
EPSON encourages each user to be responsible and respectful of the copyright laws
when using digital cameras, scanners, and ink jet printers.

Trademarks
EPSON, EPSON Stylus, ESC/P, and MicroWeave are registered trademarks and
EPSON Smart Panel is a trademark of SEIKO EPSON CORPORATION.
BorderFree and DURABrite are registered trademarks, RPM and PhotoEnhance are
trademarks, and EPSON Connection, EPSON Store, and SoundAdvice are service
marks of Epson America, Inc.
General Notice: Other product names used herein are for identification purposes only
and may be trademarks of their respective owners. EPSON disclaims any and all
rights in those marks.
Copyright © 2003 by Epson America, Inc.
7/03
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